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Verification of a 

Continuous Girder – 

Shrinkage and 

Thermal Effects 
For LUSAS version: 22.0 or above 

For software product(s):  LUSAS Bridge or LUSAS Bridge plus 

With product option(s): Steel and Composite Deck Designer (PontiEC4 – v3.6.1 or 

above) 

With additional software Microsoft Excel installed 

Description  

This example presents the design verification of a composite steel-concrete girder, with 

particular emphasis on shrinkage and thermal effects. It provides a step-by-step guide 

covering all input stages, along with instructions for interpreting key results. 

The example provides all the necessary data to calculate design forces and moments 

using finite element analysis (FEA) outside of PontiEC4, as well as the information 

needed to perform design verification within PontiEC4. It is divided into two parts: 

Part 1 focuses on extracting the required forces and moments using a finite element 

model. An Excel file containing these forces and moments, necessary for design checks 

in PontiEC4, can be directly exported from LUSAS and imported into PontiEC4. Users 

who do not use LUSAS will need to prepare this Excel file manually. 

Part 2 covers the verification of the girder using the imported forces and moments within 

PontiEC4. 
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The worked examples “Composite Bridge Deck to Eurocodes” and “Composite Highway 

Bridge” offer valuable guidance on using PontiEC4 and demonstrate its seamless 

integration with LUSAS. 

Description of Structure  

This example involves a continuous girder with two spans, each 50 metres long. The 

girder is divided into segments, which are shown below. The global analysis uses 

uncracked properties for Segment C1 and cracked properties for Segment C2. 

 

Segments C1 and C2. 

The cross-section dimensions are shown in the figure below. 

 

Cross-section dimensions. 

Metallic Girders 

The dimensions of the steel girders are summarised in the table below. 

Segment 
Name 

Top 
Flange 
Width 
(mm) 

Top 
Flange 
Thickness 
(mm) 

Steel 
Girder 
Height 
(mm) 

Web 
Thickness 
(mm) 

Bottom 
Flange 
Width 
(mm) 

Bottom 
Flange 
Thickness 
(mm) 

C1 1000 40 3000 22 1200 40 

C2 1200 60 3000 25 1200 60 
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Material 

Concrete: Class C35/45 

Structural steel: Grade S355 

Ordinary reinforcement: Class B450 

Ultimate strength of shear connectors (N/mm²): 450 

For the calculation of concrete time-dependent effects: 

Age at onset of drying shrinkage (days): 2 

Age at time considered (days): 36500 

Age when permanent loads are applied (days): 30 

Age when shrinkage loads are applied (days): 2 

Age when imposed displacements are applied (days): 30 

Exposed area (mm^2): 1950000 (= 6500 x 300) 

Exposed perimeter (mm): 6500 

Relative humidity (%): 75 

All partial safety factors are set to their default values, which can be automatically 

applied by clicking the Default button located at the bottom right of the Materials dialog 

window. 

Part 1: Finite Element Analysis - LUSAS 

The finite element analysis (FEM) was conducted using LUSAS Bridge software, though 

specific software details are excluded in the following sections. Instead, only the 

essential data is provided to enable users to independently reproduce the force/moment 

calculations. 

A brief overview of the calculation model is presented, along with the fundamental 

loadcases and their applied loads, as well as the load combinations. The resulting internal 

forces are illustrated through diagrams and tables for clarity. 

Description of the Finite Element Model and Analysis Phases 

The girder is modelled as a line beam, discretised into beam elements with six degrees 

of freedom at each node. At the central support, all translational movements and torsion 

are fully restrained. Longitudinally guided roller supports are provided at both ends of 

the girder. The mesh plane is positioned at the top flange (extrados) of the steel girders. 

The figure below depicts the finite element mesh along with the local axes of the 

elements. 
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Finite element model of the girder created in LUSAS. 

The local z-axis is directed upwards, and the following sign conventions are adopted: 

• Axial force: positive in tension 

• Bending moment: positive if it causes tension in the top fibre of the section 

• Shear force: positive when directed upwards (on the positive faces of the 

beam elements) 

For a uniformly distributed load, the moment and shear diagrams follow the shapes and 

signs shown in the figure below. 

 

Two-span beam under a vertical uniformly distributed load: bending moment and shear 

force diagrams with sign conventions. 
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The units adopted are as follows: 

Length: metres (m) 

Forces and moments: Newtons (N) and Newton-metres (Nm) 

For internal forces, both in the finite element analysis and the Excel input file for 

PontiEC4, the following notations are used: 

Fx: axial force 

Fy: shear force acting in the horizontal plane 

Fz: shear force acting in the vertical plane 

Mx: torsional moment 

My: bending moment about y 

Mz: bending moment about z 

These notations correspond to those used in the Eurocodes and their introductory 

chapters. The following Eurocode-compliant alternatives may also be used: 

M (or Mf) instead of My 

V instead of Fz 

T instead of Mx 

The verification is based solely on Fx, Fz, and My, as the influences of Fy, Mx, and Mz 

are considered negligible. 

Separate analyses are conducted to represent the four design phases considered: 

Phase 1: The bare steel girder is analysed without considering composite action. The 

slab is treated as a dead load, and the casting sequence of slab segments is ignored, 

assuming they are cast simultaneously. 

Phase 2a: The composite girder is analysed using the long-term properties of concrete, 

considering only permanent loads. 

Phase 2b: The composite girder is analysed with long-term concrete properties, focusing 

exclusively on shrinkage effects. 

Phase 3: The composite girder is analysed using the short-term properties of concrete, 

accounting for traffic loads and thermal effects. 
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Loadcases 

The phases, along with their associated loads and loadcases, are summarised in the table 

below. 

Analysis Loads Loadcases 

Phase 1 
Steel self-weight: -19500 N/m 

Slab self-weight: -48750 N/m 
Weight (G1) 

Phase 2a Non-structural permanent loads: -23400 N/m Permanent (G2) 

Phase 2b 
Shrinkage in segment C1 – sh = -2.692*10-4 in 

the slab 
Shrinkage (Gsh) 

Phase 3a 
Slab heating: T = +10° Thermal_Heat (M+) 

Slab cooling:  T = -10° Thermal_Cold (M-) 

Phase 3b 

UDL = -60000 N/m on span 1 

UDL = -27000 N/m on span 2 
Traffic 1 (Q1) 

UDL = -27000 N/m on span 1 

UDL = -60000 N/m on span 2 
Traffic 2 (Q2) 

UDL = -60000 N/m on span 1 Traffic 3 (Q3) 

UDL = -60000 N/m on span 2 Traffic 4 (Q4) 

 

Note. Where allowed by national annexes, it is recommended to use Approach 1 of EN 

1991-1-5 to calculate thermal variations. This method applies linear temperature 

gradients that produce only global hyperstatic effects, without causing internal 

hyperstatic stresses within the sections. In the following example, Approach 2 of EN 

1991-1-5 is used to model thermal variation. This approach applies a non-linear 

temperature difference of ±10°C to the slab (see figure). This choice aims to help users 

understand how to perform verifications under more complex thermal conditions. 

 

In the finite element model, the hyperstatic effects of shrinkage and thermal variation in 

the slab are accounted for by applying a mean strain and curvature to the continuous 

girder, following the procedure outlined below. 

Mean strain 

𝜀 =
𝑁

𝐸𝑎𝑐𝑐 · 𝐴
 

 

 

 
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Mean curvature (1/mm) 

𝜇 =
𝑁 · 𝑒

𝐸𝑎𝑐𝑐 · 𝐼
 

where: 

N = sh Acls Eacc / nPhase 2b Axial force due to shrinkage (N) 

N = T Acls Eacc / nPhase 3  Axial force due to thermal variation (N) 

sh  imposed shrinkage strain 

T  imposed thermal strain 

  thermal expansion coefficient (=1E-5 1/C) 

Acls  slab concrete area (mm^2) 

Eacc  modulus of elasticity of steel (N/mm^2) 

nPhase 2b long-term modular ratio for Phase 2b 

nPhase 3 short-term modular ratio for Phase 3 

e distance (mm) between the centroid of the slab and the centroid of the 

composite section in Phase 2b (shrinkage) and Phase 3 (thermal effects) 

A area (mm^2) of the equivalent steel section in Phase 2b (shrinkage) and Phase 

3 (thermal effects) 

I moment of inertia (mm^4) of the equivalent steel section in Phase 2b 

(shrinkage) and Phase 3 (thermal effects) 

The mean strain and curvature can also be expressed as equivalent temperature variation 

and gradient using the following formulas. 

∆𝑇𝑒𝑞 =
𝜀

𝛼
 

𝐺𝑟𝑎𝑑𝑒𝑞 =
𝜇

𝛼
  (

𝐶°

𝑚𝑚
) 

PontiEC4 automatically calculates the values of ΔTeq and Gradeq for each segment under 

Utilities > Equivalent ΔT > Shrinkage, Thermal. In this example, these values are applied 

only to segment C1, as segment C2 is assumed to have cracked section properties. 

In a finite element model, where shell elements represent the concrete slab and beam 

elements represent the steel girder, hyperstatic effects can also be considered by directly 

applying the imposed strains (εsh for shrinkage and αΔT for thermal effects) to the slab. 

It is then necessary to use tools that can integrate the stresses computed across the slab 

and girder to determine the internal forces at the composite section level. 
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Internal Force Diagrams 

The bending moment and shear force diagrams for each phase and loadcase are presented 

below. Axial forces are zero in this example. 

Phase 1 – Weight 
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Phase 2a – Permanent 
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Phase 2b – Shrinkage 

 

 

 

Note. The diagrams above show the hyperstatic effects resulting from the imposed 

shrinkage strain εsh applied to the slab. These hyperstatic effects must be combined with 

the corresponding isostatic (primary) effects, which PontiEC4 calculates directly from 

the input provided below: 

1) In the Materials dialog window, under the Imposed strain in the slab section, 

select the Automatic Calculation option, as shown below. Alternatively, you 

can select the Direct Input option and manually enter the shrinkage strain 

(including the sign) in the Shrinkage Deformation field – for example, –2.7E–

4.  

 
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The combination factors for shrinkage and thermal effects are used solely to 

calculate the Ultimate Limit State (ULS) shear force per unit length at the deck's 

end regions. They do not apply to the isostatic effects resulting from shrinkage 

or thermal variation. 

2) In the Forces and moments dialog window, under Phase 2b, a positive value 

must be entered in the gam*psi column for each section. This value depends on 

the limit state being considered and may vary according to the National Annex 

in use. For example, for the Ultimate Limit State (ULS), a typical value is 1.2. 

The gam*psi (γ·ψ) factor enables PontiEC4 to compute the isostatic (primary) 

effect by applying a shrinkage strain equal to sh·· = sh·1.2. For sections 

considered cracked in the global analysis – where the isostatic shrinkage effect 

is not to be taken into account – the γ·ψ value should be set to 0. 

Phase 3a – Thermal_Heat 
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Note. The diagrams above show the hyperstatic effects resulting from a positive 

thermal variation, ΔT = +10°C, applied to the slab. These hyperstatic effects must be 

combined with the corresponding isostatic (primary) effects, which PontiEC4 

calculates directly from the input provided below: 

1) In the Materials dialog window, within the Imposed strain in the slab section, 

the temperature difference (°C) can be entered. In this case, a value of 10°C is 

specified. 

 

The combination factors for shrinkage and thermal effects are used solely to 

calculate the Ultimate Limit State (ULS) shear force per unit length at the deck's 

end regions. They do not apply to the isostatic effects resulting from shrinkage 

or thermal variation. 

2) In the Forces and moments dialog window, under Phase 3a, a positive value 

must be entered in the gam*psi column for each section. This value depends on 

the limit state being considered and may vary according to the National Annex 

in use. For example, for the Ultimate Limit State (ULS), when traffic loading is 

 
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the dominant loadcase, a value of 0.9 (i.e., 1.5·0.6) may be used. The gam*psi 

(γ·ψ) factor enables PontiEC4 to compute the isostatic (primary) effect by 

applying a thermal difference equal to ΔT·· = ΔT·0.9. For sections 

considered cracked in the global analysis – where the isostatic thermal effect is 

not to be taken into account – the γ·ψ value should be set to 0. 

Phase 3a – Thermal_Cool 

 

 

Note. The diagrams above show the hyperstatic effects resulting from a negative 

thermal variation, ΔT = -10°C, applied to the slab. To associate these hyperstatic effects 

with the corresponding isostatic (primary) effects, in PontiEC4, in addition to the value 

already entered in the Materials dialog window (as explained in the previous note), 

appropriate values must be entered for γ·ψ. In the Forces and moments dialog window, 

under Phase 3a, a negative value must be entered in the gam*psi column for each 

section. For example, for the Ultimate Limit State (ULS), when traffic loading is the 

dominant loadcase, a value of -0.9 (i.e., -1.5·0.6) may be used. The gam*psi (γ·ψ) factor 

 
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enables PontiEC4 to compute the isostatic (primary) effect by applying a thermal 

difference equal to ΔT·· = -ΔT·0.9. For sections considered cracked in the global 

analysis – where the isostatic thermal effect is not to be taken into account – the γ·ψ 

value should be set to 0. 

 

Phase 3b – Traffic 1 
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Phase 3b – Traffic 2 
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Phase 3b – Traffic 3 
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Phase 3b – Traffic 4 
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ULS Combinations 

Load combinations are defined using the partial factors shown in the table below. 

Traffic loading is assumed to be the dominant variable action. 

Analysis Loadcases 
Favourable 

factor 

Unfavourable 

factor 

Phase 1 Weight (G1) 1.00 1.35 

Phase 2a Permanent (G2) 1.00 1.35 

Phase 2b Shrinkage (Gsh) 1.00 1.20 

Phase 3 

Envelope {Traffic 1 (Q1), Traffic 2 

(Q2), Traffic 3 (Q3), Traffic 4(Q4)} 
0 1.35 

Envelope {Thermal_Heat (M+), 

Thermal_Cold (M-)} 
0 1.50x0.6 
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Design Envelopes 

The Ultimate Limit State (ULS) design envelopes, grouped by design phase, are 

presented below. The design envelopes should be organised by phase, as in the case of 

composite cross-sections, stress states may be superimposed, but internal forces should 

not. Maximum values are shown in red, and minimum values in blue. 

 

Phase 1 – ULS 
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Phase 2a – ULS 
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Phase 2b – ULS 
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Phase 3a – ULS 
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Phase 3b – ULS 
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Sections to be checked in PontiEC4 

The sections to be checked, along with their corresponding positions, are shown in the 

figure and table below. 

 

 

Section X (m)  Section X (m) 

C1_1 0.000  C2_cracked_8 50.001 

C1_2 10.625  C2_cracked_9 57.500 

C1_3 21.250  C1_10 57.501 

C1_4 31.875  C1_11 68.125 

C1_5 42.500  C1_12 78.750 

C2_cracked_6 42.501  C1_13 89.375 

C2_cracked_7 50.000  C1_14 100.000 

 

Summary Table of Internal Forces 

The internal forces corresponding to the Ultimate Limit State are reported at the specified 

sections and are organised by design phase, force component (maximum or minimum), 

and section name. Only the shear force Fz and bending moment My are reported here, 

as the remaining internal forces are expected to have a negligible impact. In the γ·ψ 

column (Phases 2b and 3a), the coefficients used to compute the primary effects of 

shrinkage and thermal variation are included.  

Section Component Phase Fz My   

C1_1 Fz (Max) Phase 1 -8.9277E+05 0.0000E+00  

C1_2 Fz (Max) Phase 1 -8.9277E+05 -9.4857E+06  

C1_3 Fz (Max) Phase 1 7.5268E+05 -1.5210E+07  

C1_4 Fz (Max) Phase 1 1.7316E+06 -7.2128E+06  

C1_5 Fz (Max) Phase 1 2.3939E+06 1.1186E+07  

C2_cracked_6 Fz (Max) Phase 1 2.3939E+06 1.1186E+07  

C2_cracked_7 Fz (Max) Phase 1 2.7394E+06 3.0436E+07  

C2_cracked_8 Fz (Max) Phase 1 2.7394E+06 3.0436E+07  

C2_cracked_9 Fz (Max) Phase 1 -1.7732E+06 8.2859E+06  

C1_10 Fz (Max) Phase 1 -1.7732E+06 8.2859E+06  

C1_11 Fz (Max) Phase 1 -1.2827E+06 -5.3428E+06  

C1_12 Fz (Max) Phase 1 -5.5754E+05 -1.5210E+07  
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Section Component Phase Fz My   

C1_13 Fz (Max) Phase 1 1.2052E+06 -1.2806E+07  

C1_14 Fz (Max) Phase 1 1.2052E+06 0.0000E+00  

C1_1 Fz (Min) Phase 1 -1.2052E+06 0.0000E+00  

C1_2 Fz (Min) Phase 1 -1.2052E+06 -1.2806E+07  

C1_3 Fz (Min) Phase 1 5.5754E+05 -1.5210E+07  

C1_4 Fz (Min) Phase 1 1.2827E+06 -5.3428E+06  

C1_5 Fz (Min) Phase 1 1.7732E+06 8.2859E+06  

C2_cracked_6 Fz (Min) Phase 1 1.7732E+06 8.2859E+06  

C2_cracked_7 Fz (Min) Phase 1 -2.7394E+06 3.0436E+07  

C2_cracked_8 Fz (Min) Phase 1 -2.7394E+06 3.0436E+07  

C2_cracked_9 Fz (Min) Phase 1 -2.3939E+06 1.1186E+07  

C1_10 Fz (Min) Phase 1 -2.3939E+06 1.1186E+07  

C1_11 Fz (Min) Phase 1 -1.7316E+06 -7.2128E+06  

C1_12 Fz (Min) Phase 1 -7.5268E+05 -1.5210E+07  

C1_13 Fz (Min) Phase 1 8.9277E+05 -9.4857E+06  

C1_14 Fz (Min) Phase 1 8.9277E+05 0.0000E+00  

C1_1 My (Max) Phase 1 -8.9277E+05 0.0000E+00  

C1_2 My (Max) Phase 1 -8.9277E+05 -9.4857E+06  

C1_3 My (Max) Phase 1 5.5754E+05 -1.1267E+07  

C1_4 My (Max) Phase 1 1.2827E+06 -5.3428E+06  

C1_5 My (Max) Phase 1 2.3939E+06 1.1186E+07  

C2_cracked_6 My (Max) Phase 1 2.3939E+06 1.1186E+07  

C2_cracked_7 My (Max) Phase 1 -2.7394E+06 3.0436E+07  

C2_cracked_8 My (Max) Phase 1 -2.7394E+06 3.0436E+07  

C2_cracked_9 My (Max) Phase 1 -2.3939E+06 1.1186E+07  

C1_10 My (Max) Phase 1 -2.3939E+06 1.1186E+07  

C1_11 My (Max) Phase 1 -1.2827E+06 -5.3428E+06  

C1_12 My (Max) Phase 1 -5.5754E+05 -1.1267E+07  

C1_13 My (Max) Phase 1 8.9277E+05 -9.4857E+06  

C1_14 My (Max) Phase 1 8.9277E+05 0.0000E+00  

C1_1 My (Min) Phase 1 -1.2052E+06 0.0000E+00  

C1_2 My (Min) Phase 1 -1.2052E+06 -1.2806E+07  

C1_3 My (Min) Phase 1 7.5268E+05 -1.5210E+07  

C1_4 My (Min) Phase 1 1.7316E+06 -7.2128E+06  

C1_5 My (Min) Phase 1 1.7732E+06 8.2859E+06  

C2_cracked_6 My (Min) Phase 1 1.7732E+06 8.2859E+06  

C2_cracked_7 My (Min) Phase 1 -2.0292E+06 2.2545E+07  

C2_cracked_8 My (Min) Phase 1 -2.0292E+06 2.2545E+07  
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Section Component Phase Fz My   

C2_cracked_9 My (Min) Phase 1 -1.7732E+06 8.2859E+06  

C1_10 My (Min) Phase 1 -1.7732E+06 8.2859E+06  

C1_11 My (Min) Phase 1 -1.7316E+06 -7.2128E+06  

C1_12 My (Min) Phase 1 -7.5268E+05 -1.5210E+07  

C1_13 My (Min) Phase 1 1.2052E+06 -1.2806E+07  

C1_14 My (Min) Phase 1 1.2052E+06 0.0000E+00  

C1_1 Fz (Max) Phase 2a -3.1822E+05 0.0000E+00  

C1_2 Fz (Max) Phase 2a -3.1822E+05 -3.3811E+06  

C1_3 Fz (Max) Phase 2a 2.4168E+05 -5.5628E+06  

C1_4 Fz (Max) Phase 2a 5.7733E+05 -2.9949E+06  

C1_5 Fz (Max) Phase 2a 8.0438E+05 3.1392E+06  

C2_cracked_6 Fz (Max) Phase 2a 8.0438E+05 3.1392E+06  

C2_cracked_7 Fz (Max) Phase 2a 9.2284E+05 9.6163E+06  

C2_cracked_8 Fz (Max) Phase 2a 9.2284E+05 9.6163E+06  

C2_cracked_9 Fz (Max) Phase 2a -5.9584E+05 2.3253E+06  

C1_10 Fz (Max) Phase 2a -5.9584E+05 2.3253E+06  

C1_11 Fz (Max) Phase 2a -4.2765E+05 -2.2185E+06  

C1_12 Fz (Max) Phase 2a -1.7903E+05 -5.5628E+06  

C1_13 Fz (Max) Phase 2a 4.2960E+05 -4.5645E+06  

C1_14 Fz (Max) Phase 2a 4.2960E+05 0.0000E+00  

C1_1 Fz (Min) Phase 2a -4.2960E+05 0.0000E+00  

C1_2 Fz (Min) Phase 2a -4.2960E+05 -4.5645E+06  

C1_3 Fz (Min) Phase 2a 1.7903E+05 -5.5628E+06  

C1_4 Fz (Min) Phase 2a 4.2765E+05 -2.2185E+06  

C1_5 Fz (Min) Phase 2a 5.9584E+05 2.3253E+06  

C2_cracked_6 Fz (Min) Phase 2a 5.9584E+05 2.3253E+06  

C2_cracked_7 Fz (Min) Phase 2a -9.2284E+05 9.6163E+06  

C2_cracked_8 Fz (Min) Phase 2a -9.2284E+05 9.6163E+06  

C2_cracked_9 Fz (Min) Phase 2a -8.0438E+05 3.1392E+06  

C1_10 Fz (Min) Phase 2a -8.0438E+05 3.1392E+06  

C1_11 Fz (Min) Phase 2a -5.7733E+05 -2.9949E+06  

C1_12 Fz (Min) Phase 2a -2.4168E+05 -5.5628E+06  

C1_13 Fz (Min) Phase 2a 3.1822E+05 -3.3811E+06  

C1_14 Fz (Min) Phase 2a 3.1822E+05 0.0000E+00  

C1_1 My (Max) Phase 2a -4.2960E+05 0.0000E+00  

C1_2 My (Max) Phase 2a -3.1822E+05 -3.3811E+06  

C1_3 My (Max) Phase 2a 1.7903E+05 -4.1206E+06  

C1_4 My (Max) Phase 2a 4.2765E+05 -2.2185E+06  
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Section Component Phase Fz My   

C1_5 My (Max) Phase 2a 8.0438E+05 3.1392E+06  

C2_cracked_6 My (Max) Phase 2a 8.0438E+05 3.1392E+06  

C2_cracked_7 My (Max) Phase 2a -9.2284E+05 9.6163E+06  

C2_cracked_8 My (Max) Phase 2a -9.2284E+05 9.6163E+06  

C2_cracked_9 My (Max) Phase 2a -8.0438E+05 3.1392E+06  

C1_10 My (Max) Phase 2a -8.0438E+05 3.1392E+06  

C1_11 My (Max) Phase 2a -4.2765E+05 -2.2185E+06  

C1_12 My (Max) Phase 2a -1.7903E+05 -4.1206E+06  

C1_13 My (Max) Phase 2a 3.1822E+05 -3.3811E+06  

C1_14 My (Max) Phase 2a 3.1822E+05 0.0000E+00  

C1_1 My (Min) Phase 2a -3.1822E+05 0.0000E+00  

C1_2 My (Min) Phase 2a -4.2960E+05 -4.5645E+06  

C1_3 My (Min) Phase 2a 2.4168E+05 -5.5628E+06  

C1_4 My (Min) Phase 2a 5.7733E+05 -2.9949E+06  

C1_5 My (Min) Phase 2a 5.9584E+05 2.3253E+06  

C2_cracked_6 My (Min) Phase 2a 5.9584E+05 2.3253E+06  

C2_cracked_7 My (Min) Phase 2a -6.8359E+05 7.1232E+06  

C2_cracked_8 My (Min) Phase 2a -6.8359E+05 7.1232E+06  

C2_cracked_9 My (Min) Phase 2a -5.9584E+05 2.3253E+06  

C1_10 My (Min) Phase 2a -5.9584E+05 2.3253E+06  

C1_11 My (Min) Phase 2a -5.7733E+05 -2.9949E+06  

C1_12 My (Min) Phase 2a -2.4168E+05 -5.5628E+06  

C1_13 My (Min) Phase 2a 4.2960E+05 -4.5645E+06  

C1_14 My (Min) Phase 2a 4.2960E+05 0.0000E+00  

C1_1 Fz (Max) Phase 2b 1.7076E+05 0.0000E+00 1.20 

C1_2 Fz (Max) Phase 2b 1.7076E+05 1.8143E+06 1.20 

C1_3 Fz (Max) Phase 2b 1.7076E+05 3.6286E+06 1.20 

C1_4 Fz (Max) Phase 2b 1.7076E+05 5.4429E+06 1.20 

C1_5 Fz (Max) Phase 2b 1.7076E+05 7.2572E+06 1.20 

C2_cracked_6 Fz (Max) Phase 2b 1.7076E+05 7.2572E+06 0.00 

C2_cracked_7 Fz (Max) Phase 2b 1.7076E+05 8.5378E+06 0.00 

C2_cracked_8 Fz (Max) Phase 2b 1.7076E+05 8.5378E+06 0.00 

C2_cracked_9 Fz (Max) Phase 2b -1.4230E+05 6.0476E+06 0.00 

C1_10 Fz (Max) Phase 2b -1.4230E+05 6.0476E+06 1.20 

C1_11 Fz (Max) Phase 2b -1.4230E+05 4.5357E+06 1.20 

C1_12 Fz (Max) Phase 2b -1.4230E+05 3.0238E+06 1.20 

C1_13 Fz (Max) Phase 2b -1.4230E+05 1.5119E+06 1.20 

C1_14 Fz (Max) Phase 2b -1.4230E+05 0.0000E+00 1.20 
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Section Component Phase Fz My   

C1_1 Fz (Min) Phase 2b 1.4230E+05 0.0000E+00 1.20 

C1_2 Fz (Min) Phase 2b 1.4230E+05 1.5119E+06 1.20 

C1_3 Fz (Min) Phase 2b 1.4230E+05 3.0238E+06 1.20 

C1_4 Fz (Min) Phase 2b 1.4230E+05 4.5357E+06 1.20 

C1_5 Fz (Min) Phase 2b 1.4230E+05 6.0476E+06 1.20 

C2_cracked_6 Fz (Min) Phase 2b 1.4230E+05 6.0476E+06 0.00 

C2_cracked_7 Fz (Min) Phase 2b -1.7076E+05 8.5378E+06 0.00 

C2_cracked_8 Fz (Min) Phase 2b -1.7076E+05 8.5378E+06 0.00 

C2_cracked_9 Fz (Min) Phase 2b -1.7076E+05 7.2572E+06 0.00 

C1_10 Fz (Min) Phase 2b -1.7076E+05 7.2572E+06 1.20 

C1_11 Fz (Min) Phase 2b -1.7076E+05 5.4429E+06 1.20 

C1_12 Fz (Min) Phase 2b -1.7076E+05 3.6286E+06 1.20 

C1_13 Fz (Min) Phase 2b -1.7076E+05 1.8143E+06 1.20 

C1_14 Fz (Min) Phase 2b -1.7076E+05 0.0000E+00 1.20 

C1_1 My (Max) Phase 2b 1.4230E+05 0.0000E+00 1.20 

C1_2 My (Max) Phase 2b 1.7076E+05 1.8143E+06 1.20 

C1_3 My (Max) Phase 2b 1.7076E+05 3.6286E+06 1.20 

C1_4 My (Max) Phase 2b 1.7076E+05 5.4429E+06 1.20 

C1_5 My (Max) Phase 2b 1.7076E+05 7.2572E+06 1.20 

C2_cracked_6 My (Max) Phase 2b 1.7076E+05 7.2572E+06 0.00 

C2_cracked_7 My (Max) Phase 2b 1.7076E+05 8.5378E+06 0.00 

C2_cracked_8 My (Max) Phase 2b 1.7076E+05 8.5378E+06 0.00 

C2_cracked_9 My (Max) Phase 2b -1.7076E+05 7.2572E+06 0.00 

C1_10 My (Max) Phase 2b -1.7076E+05 7.2572E+06 1.20 

C1_11 My (Max) Phase 2b -1.7076E+05 5.4429E+06 1.20 

C1_12 My (Max) Phase 2b -1.7076E+05 3.6286E+06 1.20 

C1_13 My (Max) Phase 2b -1.7076E+05 1.8143E+06 1.20 

C1_14 My (Max) Phase 2b -1.4230E+05 0.0000E+00 1.20 

C1_1 My (Min) Phase 2b 1.7076E+05 0.0000E+00 1.20 

C1_2 My (Min) Phase 2b 1.4230E+05 1.5119E+06 1.20 

C1_3 My (Min) Phase 2b 1.4230E+05 3.0238E+06 1.20 

C1_4 My (Min) Phase 2b 1.4230E+05 4.5357E+06 1.20 

C1_5 My (Min) Phase 2b 1.4230E+05 6.0476E+06 1.20 

C2_cracked_6 My (Min) Phase 2b 1.4230E+05 6.0476E+06 0.00 

C2_cracked_7 My (Min) Phase 2b 1.4230E+05 7.1149E+06 0.00 

C2_cracked_8 My (Min) Phase 2b 1.4230E+05 7.1149E+06 0.00 

C2_cracked_9 My (Min) Phase 2b -1.4230E+05 6.0476E+06 0.00 

C1_10 My (Min) Phase 2b -1.4230E+05 6.0476E+06 1.20 
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Section Component Phase Fz My   

C1_11 My (Min) Phase 2b -1.4230E+05 4.5357E+06 1.20 

C1_12 My (Min) Phase 2b -1.4230E+05 3.0238E+06 1.20 

C1_13 My (Min) Phase 2b -1.4230E+05 1.5119E+06 1.20 

C1_14 My (Min) Phase 2b -1.7076E+05 0.0000E+00 1.20 

C1_1 Fz (Max) Phase 3a 6.5880E+04 0.0000E+00 0.90 

C1_2 Fz (Max) Phase 3a 6.5880E+04 6.9997E+05 -0.90 

C1_3 Fz (Max) Phase 3a 6.5880E+04 1.3999E+06 -0.90 

C1_4 Fz (Max) Phase 3a 6.5880E+04 2.0999E+06 -0.90 

C1_5 Fz (Max) Phase 3a 6.5880E+04 2.7999E+06 -0.90 

C2_cracked_6 Fz (Max) Phase 3a 6.5880E+04 2.7999E+06 0.00 

C2_cracked_7 Fz (Max) Phase 3a 6.5880E+04 3.2940E+06 0.00 

C2_cracked_8 Fz (Max) Phase 3a 6.5880E+04 3.2940E+06 0.00 

C2_cracked_9 Fz (Max) Phase 3a 6.5880E+04 -2.7999E+06 0.00 

C1_10 Fz (Max) Phase 3a 6.5880E+04 -2.7999E+06 0.90 

C1_11 Fz (Max) Phase 3a 6.5880E+04 -2.0999E+06 0.90 

C1_12 Fz (Max) Phase 3a 6.5880E+04 -1.3999E+06 0.90 

C1_13 Fz (Max) Phase 3a 6.5880E+04 -6.9997E+05 0.90 

C1_14 Fz (Max) Phase 3a 6.5880E+04 0.0000E+00 0.90 

C1_1 Fz (Min) Phase 3a -6.5880E+04 0.0000E+00 0.90 

C1_2 Fz (Min) Phase 3a -6.5880E+04 -6.9997E+05 0.90 

C1_3 Fz (Min) Phase 3a -6.5880E+04 -1.3999E+06 0.90 

C1_4 Fz (Min) Phase 3a -6.5880E+04 -2.0999E+06 0.90 

C1_5 Fz (Min) Phase 3a -6.5880E+04 -2.7999E+06 0.90 

C2_cracked_6 Fz (Min) Phase 3a -6.5880E+04 -2.7999E+06 0.00 

C2_cracked_7 Fz (Min) Phase 3a -6.5880E+04 -3.2940E+06 0.00 

C2_cracked_8 Fz (Min) Phase 3a -6.5880E+04 -3.2940E+06 0.00 

C2_cracked_9 Fz (Min) Phase 3a -6.5880E+04 2.7999E+06 0.00 

C1_10 Fz (Min) Phase 3a -6.5880E+04 2.7999E+06 -0.90 

C1_11 Fz (Min) Phase 3a -6.5880E+04 2.0999E+06 -0.90 

C1_12 Fz (Min) Phase 3a -6.5880E+04 1.3999E+06 -0.90 

C1_13 Fz (Min) Phase 3a -6.5880E+04 6.9997E+05 -0.90 

C1_14 Fz (Min) Phase 3a -6.5880E+04 0.0000E+00 0.90 

C1_1 My (Max) Phase 3a -6.5880E+04 0.0000E+00 0.90 

C1_2 My (Max) Phase 3a 6.5880E+04 6.9997E+05 -0.90 

C1_3 My (Max) Phase 3a 6.5880E+04 1.3999E+06 -0.90 

C1_4 My (Max) Phase 3a 6.5880E+04 2.0999E+06 -0.90 

C1_5 My (Max) Phase 3a 6.5880E+04 2.7999E+06 -0.90 

C2_cracked_6 My (Max) Phase 3a 6.5880E+04 2.7999E+06 0.00 
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Section Component Phase Fz My   

C2_cracked_7 My (Max) Phase 3a 6.5880E+04 3.2940E+06 0.00 

C2_cracked_8 My (Max) Phase 3a 6.5880E+04 3.2940E+06 0.00 

C2_cracked_9 My (Max) Phase 3a -6.5880E+04 2.7999E+06 0.00 

C1_10 My (Max) Phase 3a -6.5880E+04 2.7999E+06 -0.90 

C1_11 My (Max) Phase 3a -6.5880E+04 2.0999E+06 -0.90 

C1_12 My (Max) Phase 3a -6.5880E+04 1.3999E+06 -0.90 

C1_13 My (Max) Phase 3a -6.5880E+04 6.9997E+05 -0.90 

C1_14 My (Max) Phase 3a 6.5880E+04 0.0000E+00 0.90 

C1_1 My (Min) Phase 3a 6.5880E+04 0.0000E+00 0.90 

C1_2 My (Min) Phase 3a -6.5880E+04 -6.9997E+05 0.90 

C1_3 My (Min) Phase 3a -6.5880E+04 -1.3999E+06 0.90 

C1_4 My (Min) Phase 3a -6.5880E+04 -2.0999E+06 0.90 

C1_5 My (Min) Phase 3a -6.5880E+04 -2.7999E+06 0.90 

C2_cracked_6 My (Min) Phase 3a -6.5880E+04 -2.7999E+06 0.00 

C2_cracked_7 My (Min) Phase 3a -6.5880E+04 -3.2940E+06 0.00 

C2_cracked_8 My (Min) Phase 3a -6.5880E+04 -3.2940E+06 0.00 

C2_cracked_9 My (Min) Phase 3a 6.5880E+04 -2.7999E+06 0.00 

C1_10 My (Min) Phase 3a 6.5880E+04 -2.7999E+06 0.90 

C1_11 My (Min) Phase 3a 6.5880E+04 -2.0999E+06 0.90 

C1_12 My (Min) Phase 3a 6.5880E+04 -1.3999E+06 0.90 

C1_13 My (Min) Phase 3a 6.5880E+04 -6.9997E+05 0.90 

C1_14 My (Min) Phase 3a -6.5880E+04 0.0000E+00 0.90 

C1_1 Fz (Max) Phase 3b 2.3470E+05 0.0000E+00  

C1_2 Fz (Max) Phase 3b 2.3470E+05 2.4936E+06  

C1_3 Fz (Max) Phase 3b 4.6687E+05 -1.7511E+07  

C1_4 Fz (Max) Phase 3b 1.3275E+06 -1.2551E+07  

C1_5 Fz (Max) Phase 3b 1.9097E+06 1.5537E+06  

C2_cracked_6 Fz (Max) Phase 3b 1.9097E+06 1.5537E+06  

C2_cracked_7 Fz (Max) Phase 3b 2.2134E+06 1.7015E+07  

C2_cracked_8 Fz (Max) Phase 3b 2.2134E+06 1.7015E+07  

C2_cracked_9 Fz (Max) Phase 3b 0.0000E+00 0.0000E+00  

C1_10 Fz (Max) Phase 3b 0.0000E+00 0.0000E+00  

C1_11 Fz (Max) Phase 3b 0.0000E+00 0.0000E+00  

C1_12 Fz (Max) Phase 3b 4.9937E+05 -1.9756E+07  

C1_13 Fz (Max) Phase 3b 1.3600E+06 -1.4450E+07  

C1_14 Fz (Max) Phase 3b 1.3600E+06 0.0000E+00  

C1_1 Fz (Min) Phase 3b -1.3600E+06 0.0000E+00  

C1_2 Fz (Min) Phase 3b -1.3600E+06 -1.4450E+07  
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Section Component Phase Fz My   

C1_3 Fz (Min) Phase 3b -4.9937E+05 -1.9756E+07  

C1_4 Fz (Min) Phase 3b 0.0000E+00 0.0000E+00  

C1_5 Fz (Min) Phase 3b 0.0000E+00 0.0000E+00  

C2_cracked_6 Fz (Min) Phase 3b 0.0000E+00 0.0000E+00  

C2_cracked_7 Fz (Min) Phase 3b -2.2134E+06 1.7015E+07  

C2_cracked_8 Fz (Min) Phase 3b -2.2134E+06 1.7015E+07  

C2_cracked_9 Fz (Min) Phase 3b -1.9097E+06 1.5537E+06  

C1_10 Fz (Min) Phase 3b -1.9097E+06 1.5537E+06  

C1_11 Fz (Min) Phase 3b -1.3275E+06 -1.2551E+07  

C1_12 Fz (Min) Phase 3b -4.6687E+05 -1.7511E+07  

C1_13 Fz (Min) Phase 3b -2.3470E+05 2.4936E+06  

C1_14 Fz (Min) Phase 3b -2.3470E+05 0.0000E+00  

C1_1 My (Max) Phase 3b 2.3470E+05 0.0000E+00  

C1_2 My (Max) Phase 3b 2.3470E+05 2.4936E+06  

C1_3 My (Max) Phase 3b 2.3470E+05 4.9873E+06  

C1_4 My (Max) Phase 3b 2.3470E+05 7.4809E+06  

C1_5 My (Max) Phase 3b 2.3470E+05 9.9746E+06  

C2_cracked_6 My (Max) Phase 3b 2.3470E+05 9.9746E+06  

C2_cracked_7 My (Max) Phase 3b 2.2134E+06 1.7015E+07  

C2_cracked_8 My (Max) Phase 3b 2.2134E+06 1.7015E+07  

C2_cracked_9 My (Max) Phase 3b -2.3470E+05 9.9746E+06  

C1_10 My (Max) Phase 3b -2.3470E+05 9.9746E+06  

C1_11 My (Max) Phase 3b -2.3470E+05 7.4809E+06  

C1_12 My (Max) Phase 3b -2.3470E+05 4.9873E+06  

C1_13 My (Max) Phase 3b -2.3470E+05 2.4936E+06  

C1_14 My (Max) Phase 3b -2.3470E+05 0.0000E+00  

C1_1 My (Min) Phase 3b -1.2544E+06 0.0000E+00  

C1_2 My (Min) Phase 3b -1.3600E+06 -1.4450E+07  

C1_3 My (Min) Phase 3b -4.9937E+05 -1.9756E+07  

C1_4 My (Min) Phase 3b 1.2219E+06 -1.5917E+07  

C1_5 My (Min) Phase 3b 1.8041E+06 -2.9348E+06  

C2_cracked_6 My (Min) Phase 3b 1.8041E+06 -2.9348E+06  

C2_cracked_7 My (Min) Phase 3b 0.0000E+00 0.0000E+00  

C2_cracked_8 My (Min) Phase 3b 0.0000E+00 0.0000E+00  

C2_cracked_9 My (Min) Phase 3b -1.8041E+06 -2.9348E+06  

C1_10 My (Min) Phase 3b -1.8041E+06 -2.9348E+06  

C1_11 My (Min) Phase 3b -1.2219E+06 -1.5917E+07  

C1_12 My (Min) Phase 3b 4.9937E+05 -1.9756E+07  
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Section Component Phase Fz My   

C1_13 My (Min) Phase 3b 1.3600E+06 -1.4450E+07  

C1_14 My (Min) Phase 3b 1.2544E+06 0.0000E+00  

 

Part 2: Design checks – PontiEC4 

This section provides a detailed description of the steps required to perform design 

checks within PontiEC4. 

The units adopted are as follows: 

Length: millimetres (mm) 

Forces and moments: Newtons (N) and Newton-metres (Nm) 

Stresses: N/mm² 

Keywords 

Steel, Composite, Deck, Designer, EC4, Design, Checking, Import, Export, ULS, 

Shrinkage, Thermal Variation, Isostatic Effects, Hyperstatic Effects. 

Associated files 

Reference files associated with this example: 

❑ Ex_Shrinkage-Thermal_Initial.csv – Input file containing data 

related to materials, shear lag, and segment geometry 

❑ Ex_Shrinkage-Thermal.csv – Complete input file with materials, 

geometry, and internal forces 

❑ Ex_Shrinkage-Thermal_Forces-Moments.xlsx – Excel file used 

to input internal forces into PontiEC4 

❑ Ex_Shrinkage-Thermal_Phase1.csv – Input file including only 

Phase 1 forces, with free top flange and no slab 

❑ Ex_Shrinkage-Thermal.mdl – LUSAS model 

Method and Objectives 

The key steps for using the PontiEC4 Steel and Composite Deck Designer with LUSAS 

are as follows: 

❑ Step 1: Input material properties 

❑ Step 2: Define effective slab width (shear lag) 

❑ Step 3: Input segment geometry 

 
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❑ Step 4: Calculate equivalent thermal gradients (shrinkage and thermal 

variation) 

❑ Step 5: Perform structural analysis 

❑ Step 6: Prepare internal force input file  

❑ Step 7: Import internal forces 

❑ Step 8: Visualise results 

❑ Step 9: Perform Phase 1 verifications 

Step 1: Input Material Properties 

• Start a new project by selecting File > New from the menu. Save the file as 

Ex_Shrinkage-Thermal.csv in your working directory. 

• In the Materials dialog window, click the Default button located at the bottom 

right. 

• Proceed through the input sections as illustrated in the following figures. Fields 

highlighted in yellow indicate data that has been added or modified from the 

default values. 

Concrete slab 
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Modular ratios 

 

Imposed strain in the slab 

 

Concrete age 
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Environment 

 

Shear connection 
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Steel  

 

Fatigue – Equivalent damage factors 

 

Equivalent damage factors have not been input, as fatigue verification is not part of this 

example. 

• Save the current project from the File > Save menu. 
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Step 2: Define Effective Slab Width (Shear Lag) 

• From the menu, go to Utilities > Shear lag slab and flanges. 

• In the Array of spans field, enter the span lengths: 50 50, then click the button 

 located to the right of the input box. 

• Enter the required values in the first row. To apply the same values to the 

remaining rows, right-click and use the Copy/Paste options. 

 

• Click the Calculate button in the bottom-right corner. The effective widths will 

be calculated and displayed in the table. 

 

Edit the effective width at X = 0 m and X = 100 m by setting both to 6500 mm, 

then click Exit. 
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Step 3: Input Segment Geometry 

• Enter the input data for segment C1. 

Segment name 

 

Note. At this stage, only one section, named S1 and positioned at X = 0 m, is added. 

The remaining sections requiring verification will be imported later from the Excel file 

containing the internal forces from the finite element analysis. 

Structural steel 

 

Advanced options for flanges 

 

 
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Vertical stiffeners 

 

Fatigue 

 

Concrete slab 

 

Reinforcing bars 
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Shear connection 

 

• Click Add to list to add Segment C1. It will appear in the treeview on the right-

hand side of the Geometry dialog window. PontiEC4 will now be in 

GEOMETRY edit mode, as indicated in the status bar at the bottom left. Any 

previously entered data can be modified – updates will be applied automatically 

upon exiting the input fields. 

• To add segment C2, double-click on segment C1 (Input GEOMETRY mode). 

This will initiate the input process for a new segment, automatically copying all 

data previously entered for C1. 

 

• Consider the following inputs: 

Segment name 

 



Verification of a Continuous Girder – Shrinkage and Thermal Effects 

41 
 

Structural steel 

  

Reinforcing bars 

 

• Click Add to list to add Segment C2. It will appear in the treeview on the right-

hand side of the Geometry dialog window. 

• From the File menu, select Save to save the updated file. 

Note. The steps completed so far can be replicated by opening the provided file 

Ex_Shrinkage-Thermal_Initial.csv. 

Step 4: Calculate Equivalent Thermal Gradients (Shrinkage 

and Thermal Variation) 

In the case of a single-line model, either imposed strains and curvatures or equivalent 

temperature variations – both for shrinkage and thermal effects – can be used, as 

calculated in PontiEC4. Step 4 is optional, since these quantities can also be computed 

 
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independently, outside of PontiEC4. For a detailed explanation of the provided values 

and the associated calculation method, refer to the earlier section titled Loadcases. 

• Open the Equivalent Temperature Variation dialog window for shrinkage 

by navigating to: Utilities > Equivalent DT > Shrinkage 

 

• Open the Equivalent Temperature Variation dialog window for thermal 

effects by navigating to: Utilities > Equivalent DT > Thermal 

 

Step 5: Perform Structural Analysis 

The information provided in the previous sections can be used to carry out a static 

analysis and determine the required forces and moments. 

Step 6: Prepare Internal Force Input File 

An internal force input file is required to provide PontiEC4 with the necessary forces and 

moments. 

• Retrieve the Ponti EC4 Export Template.xls file, provided with the software, from 

the directory: [Installation folder]\Modelli_EN and copy it to your working directory. 

• Open the file and save it with a new name in your working directory. 

• It is recommended to name the file Ex_Shrinkage-Thermal_Forces-Moments and 

use one of the following formats: .xls, .xlsx, or .xlsm (the .xlsm format should be 

used if you intend to add your own VBA code). 

• All three formats are fully compatible with PontiEC4. 

Note. The required forces and moments can be exported directly from LUSAS using 

the dedicated export tool. The resulting file can then be imported into PontiEC4. 

The internal forces import file must contain five predefined worksheets. The user may 

add additional worksheets, but only after these five. 

 
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The allowed names for each worksheet are: 

1. ULS Fundamental or SLU fondamentale or SLU_fond 

2. SLS Characteristic or SLE caratteristica or SLE_caratt 

3. Fatigue or SL fatica or SLF 

4. SLS Frequent or SLE frequente or SLE_frequente 

5. Model Info or Info_model 

Model Info sheet 

Within the Model Info sheet, PontiEC4 processes data only from the Section and X(m) 

columns, which are highlighted in yellow. The remaining columns are not used by the 

program, but the user can still fill them in if they want to add extra details for 

documentation, clarity, or completeness. 

 

Users must provide the list of sections to be checked in PontiEC4 and specify their 

position along the longitudinal axis of the structure.  

Section names must follow the convention: “Segment Name” + “_” + “Section Name”. 

In this example, the two segments are designated as C1 and C2, and the sections within 

each segment are numbered sequentially (see Sections to be checked in PontiEC4). The 

sections of segment C2 are assumed to be cracked in the global analysis, and the 

designation “cracked” is added to their names. Columns 3 and 5 must be filled with the 

data shown in the table below. 

Element Node Section Cracked X(m) Y(m) Z(m) 
  C1_1  0.000   

  C1_2  10.625   

  C1_3  21.250   

  C1_4  31.875   

  C1_5  42.500   

  C2_cracked_6  42.501   

  C2_cracked_7  50.000   

  C2_cracked_8  50.001   

  C2_cracked_9  57.500   

  C1_10  57.501   

  C1_11  68.125   
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  C1_12  78.750   

  C1_13  89.375   

  C1_14  100.000   

 

Note. The 14 sections listed in the table above are not present in PontiEC4 and will 

therefore be created automatically when the Excel file is imported. Each section will be 

linked to the appropriate segment, identified by the text preceding the first special 

character (“_”). 

In segment C1, the following sections will be created: 1, 2, …, 5 and 10, 11, …, 14. 

In segment C2, the following sections will be created: cracked_6, …, cracked_9. 

During the import process, each section will be assigned an effective slab width derived 

from the shear lag table (see Step 2), using linear interpolation based on the X-coordinate. 

Finally, note that coincident X-coordinates will be slightly offset by adding 1 mm to one 

of them to ensure the correct ordering of sections in all contexts where graphs are plotted 

as a function of X. 

ULS Fundamental sheet 

PontiEC4 reads columns 1, 4, 5, 6, 8, 9, 10, and 12, which are highlighted in yellow. 

While the 9th column (torsional moment) is read, it is not used by the program. The 

remaining columns are optional and may be completed by the user to provide additional 

information for documentation, clarity, or completeness. 

 

Each row should contain a set of internal forces, preferably organised by Phase, then by 

Internal Force, and finally by Section. 

However, the sets of internal forces may be arranged in any order, as adherence to this 

suggested format is not mandatory. 

The following phase names must be used: 

“Phase 1” or “Fase 1” or “Fase1” 

“Phase 2a” or “Fase 2a” or “Fase2a” 

“Phase 2b” or “Fase 2b” or “Fase2b” 

“Phase 2c” or “Fase 2c” or “Fase2c” 

“Phase 3a” or “Fase 3a” or “Fase3a” 

“Phase 3b” or “Fase 3b” or “Fase3b” 

The following component names must be used: 

“My (Max)” or  “Mmax” 

 
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“My (Min)” or “Mmin” 

“Fz (Max)” or “Vmax” 

“Fz (Min)” or “Vmin” 

Maximum and minimum values (Max/Min) must be organised based on the sign of the 

internal forces, as defined in the Description of the Finite Element Model and Analysis 

Phases section of this example. 

The name of each section must be specified in column 1 (Section), and the corresponding 

internal forces must be provided in columns 6, 8, 9, and 10. Column 12 (γ·ψ) is used 

only for Phase 2b and Phase 3a. For Phase 2b, the γ·ψ values must be positive, whereas 

for Phase 3a, they may be either positive or negative. For further information, refer to 

the notes of the following sections: Phase 2b – Shrinkage, Phase 3a – Thermal_Heat, 

and Phase 3a – Thermal_Cool. 

The information provided to this point is sufficient to complete the ULS Fundamental 

sheet. The necessary internal forces can be obtained either from the Internal Force 

Summary Table paragraph or from the Ex_Shrinkage-Thermal_Forces-Moments.xls 

file. 

The steps required to complete the ULS Fundamental sheet can likewise be applied to 

the sheets corresponding to the other limit states, which are not considered in this 

example. 

Step 7: Import Internal Forces 

• Reopen PontiEC4 and import the file Ex_Shrinkage-Thermal_Forces-

Moments.xls file. A notification message will appear, prompting the user to 

confirm whether the newly detected sections should be added to the existing 

segments. Click Yes. 

The status bar in the bottom-left corner displays the progress of the import operations. 

• In the Geometry dialog window, delete sections C1_S1 and C2_S1. After this, 

only the sections imported from the Excel file will remain. 

• Save the current file using the File > Save menu. 

Step 8: Visualise Results 

• Open the Results window, which provides a detailed view of the results. 

• Verification of section C2_cracked_8  

Within the Cross-sections and design combinations area, select the 

C2_cracked_8 section and the ULS Fundamental, Mmax combination, as 

shown below. 
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• Verify the internal forces against those shown in the diagrams presented earlier. 

 

Note. The internal forces for Phase 2b are presented in two rows in the Forces and 

Moments table. The first row shows the hyperstatic effect, with M = 8.54E6 Nm. The 

second row shows the isostatic effect, which is zero for the considered section, since γ·ψ 

= 0. Although PontiEC4 calculates the isostatic shrinkage moment, it becomes zero due 

to γ·ψ = 0. 

For Phase 3a, the internal forces are also presented in two rows. The first row contains 

the hyperstatic effects, and the second row shows the sum of hyperstatic and isostatic 

effects. In this case, both rows have the same values because γ·ψ = 0 for thermal effects. 

• Check the classification of the section in the Plastic check tab.  

End of Phase 3: In this example, the section is classified as Class 4, so plastic 

verification is not applicable. Stress verification must instead be carried out on 

the effective section. 

 
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Note. The classification is generally performed for the end of Phase 3, where the top 

flange is considered stable even under compression, as it is connected to the slab. This 

assumption can be applied by selecting the Top flange in Class 1 option in the 

Geometry dialog window. The software also performs classification for the end of Phase 

1, disregarding the Top flange in Class 1 option and considering only the Phase 1 loads. 

The result of this classification is displayed at the bottom in red. This approach alerts the 

user to the need for verification for the end of Phase 1 as well, which may be more critical 

than that for Phase 3. 

• Examine the stress check for section C2_cracked_8 in the Stresses tab, 

selecting the Stresses of effective cross-section option. The stress calculation 

is performed on fibres numbered 0 through 8, as shown in the figure. 

 

 
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The calculation of stresses in the concrete is performed assuming the section 

is uncracked. The stresses in fibres 0 – 8 are presented in columns labelled with 

N.C. in the header. As an example, the stress in fibre 8 (top of the slab) is: 

σ8 (N.C.) = 1.00 + 0.94 + 0.55 + 2.84 = 5.33 MPa 

End of Phase 3: The slab is classified as CRACKED because the concrete 

stress in the median fibre is: 

σ = (5.33 + 3.34) / 2 = 4.33 > 0 

The “m” next to CRACKED indicates that the check is performed in the 

median fibre. This setting can be changed via Tools > Options. 

 

The stress verification is performed assuming the concrete cannot carry 

tension. In this example, the maximum utilisation factor of the section 

corresponds to fibre 0: 

σ0 (C) = -131.5 - 38.4 – 34.1 - 13.2 – 67.9 = -285.1 MPa 
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η1 = 285.1  / (335 / 1.05) = 0.89 

• Verification of section C1_3 

Within the Cross-sections and design combinations area, select the C1_3 

section and the ULS Fundamental, Mmin combination. 

• Check the classification of the section in the Plastic check tab.  

End of Phase 3: In this example, the section is classified as Class 1, allowing 

plastic verification. The resulting utilisation factor is 0.536. 

End of Phase 1: In this example, the section is classified as Class 4. Step 9: 

Perform Phase 1 Verifications describes this verification. 

 

 

 

• Examine the stress check for section C1_3 in the Stresses tab, selecting the 

Stresses of gross cross-section option. The stress calculation is performed on 

fibres numbered 0 through 8, as shown in the figure. 
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End of Phase 3: The slab is classified as UNCRACKED because the concrete 

stress in the median fibre is: 

σ8 (N.C.) = (-2.15 + 0.19) / 2 = -0.98 MPa 

 

 

The stress verification is performed assuming the concrete is uncracked. In this 

example, the maximum utilisation factor of the section corresponds to fibre 0: 

σ0 (N.C.) = 91.1 + 27.4 - 6.2 - 3.6 + 93.3 = 202 MPa 

η1 = 202 / (355 / 1.05) = 0.6 

The stresses calculated for Phases 2b and 3a result from the combined effects 

of: 

1) The stress state due to hyperstatic effects 

2) The stress state due to isostatic effects 
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3) The local stresses in the slab 

For shrinkage, the local effect acts only on the concrete, whereas for thermal 

effects, it also affects the reinforcement. 

The forces/moments shown in the following figure, highlighted in yellow, are 

extracted from the Results dialog window. 

 

 

 

 

The geometric properties used in the calculations are shown in the Geometric 

Properties 2 tab. 
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Calculations for Shrinkage (Phase 2b): 

1) Hyperstatic effect: M = 3.02E6 Nm, N = 0 

2) Isostatic effect: M = -7.83E6 Nm, N = -9.15E6 N 

3) Isostatic effect (concrete): εsh = -2.692E-4 · 1.2 

 

Calculations for Thermal Effects (Phase 3a): 

1) + 2) Hyperstatic + Isostatic effects: M = -1.82E6 Nm, N = -5.98E6 

3) Local effect in the slab and rebars: ε = α ΔT γψ = 1E-5 · 10 · (-0.9) = -

9E-5 
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Step 9: Perform Phase 1 Verifications 

The calculations are carried out under the following assumptions: 

1) Phase of the bare steel girder, with the slab inactive 

2) The top flange is unrestrained 

3) Only Phase 1 loads are considered 

 

• Save the current project under a new name. For example: Ex_Shrinkage-

Thermal_Phase1.csv.  

• In the Forces and Moments dialog window, right-click and select Reset to 

remove all forces/moments previously entered for Phases 2a, 2b, 3a, and 3b. 
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• The changes that must be made in the Geometry dialog window can be applied 

to each segment individually, or more efficiently by right-clicking and selecting 

Edit Segments by data grid to modify multiple segments at once. 

 

• In the Edit Segment Parameters dialog window, go to View and select only 

Structural steel, Slab concrete, and Reinforcing bars. 

 

• Next, untick the Top flange in Class 1 option and set the inputs highlighted in 

yellow to 0. Click OK to apply the changes. 
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• Open the Results dialog window to view the verification results for section 

C1_3. The verification is performed assuming the section is Class 4. 

 

 

All results can also be reviewed in summarised form in the Summary of results dialog 

window. Reports can be generated through Window > Report, and graphs for various 

entities can be created via Utilities > Graphs. For additional information, refer to the 

PontiEC4 Help system. 


